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Abstract- Slotted waveguide antenna (SWA) arrays have 
different advantages in terms of design, weight, volume, 
power handling, directivity, and efficiency. For broadwall 
SWAs, the slot displacements from the wall centerline 
determine the antenna's side lobe level (SLL). It 
demonstrates how to use a simple novel approach to 
create broad wall SWAs with acceptable SLLs. Given the 
needed SLL and operating frequency, this algorithm 
discovers the slots length, width, locations along the 
length of the waveguide, and displacements from the 
centerline for a given number of identical longitudinal 
slots. Because all slots have the same length and the 
displacements are calculated using closed-form equations, 
this approach is much easier than prior methods. A 
computer programme was designed to do the design 
calculations and generate the needed slots data. The 
Taylor, Chebyshev, and binomial distributions are all used 
in instances. In these cases, elliptical slots are employed 
because their rounded corners make them more resistant 
in high-power applications. The results of prototyping and 
testing a SWA are consistent with the design goals.. 

Keywords: SWA Antenna, SLL, E-Plane, H-Plane, Bandwidth, 
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1. INTRODUCTION 

Rectangular Slotted Waveguide Antennas (SWAs) 
transmit radiation through slots carved in the broad or 
thin wall of a rectangular waveguide. As a result, the 
radiating elements are integrated into the waveguide's 
feed system, resulting in a simplified design that does not 
require balloons or matching networks [5].SWAs also have 
a low weight and small volume, as well as a high power 
handling capacity, high efficiency, and an excellent 
reflection coefficient. They've been perfect for numerous 
radar, communications, navigation, and high-power 
microwave applications because of this. Depending on 
how the wave propagates inside the waveguide, SWAs can 
be resonant or non-resonant., The former is a standing 
wave, whereas the later is a travelling wave [6]. Although 
the traveling-wave SWA has a higher bandwidth, it 
requires a matching terminating load to absorb the wave 
and prevent it from being reflected, reducing its efficiency. 
It also has the drawback of the main beam direction being 
dependent on the operating frequency. The end of the 
waveguide in resonant SWAs is terminated with a short 

circuit, resulting in improved efficiency due to no power 
loss at the waveguide end. Furthermore, regardless of 
frequency, the primary beam is normal to the array, 
although these benefits come at the cost of a restricted 
operation band [3]. 

2. Background 

It demonstrated a planar SWA at 140 GHz. The 
feeder SWA, which consists of a feeding slot, an overrode 
cavity, and coupling slots, was developed to provide 
excitations of the same amplitude but in alternating 
phases. An integrated power divider and phase shifter 
were used to accomplish this [4]. Coupling was also done 
using longitudinal slots with the same lengths and offsets. 
Kumar et al22 proposed using a planar SWA in the X-band. 
The desired current distribution was synthesised using a 
genetic algorithm paired with Schelkunoff's unit circle 
approach. The inclined coupling slot layer and a feed layer 
with a power divider were the two layers that made up the 
feeder. Zhang et al.23 have demonstrated a planar SWA 
that operates at 40 GHz. It was made up of five layers, with 
side lobe levels suppressed using a four-corner-fed 
structure with angled coupling slots. An input aperture, 
feeding waveguide, and coupling slots made up the feeder. 
Coburn et al24 used inclined coupling slots to feed four 8 x 
8 sub array SWAs with one layer of feeding but four 
separate feeding [2][3] structures to produce low sidelobe 
levels for HPM applications. A planar SWA for HPM 
applications was also presented by Kim et al. Radiating 
slot plate, radiating waveguide, feeding waveguide, and E-
plane septum divider were the four layers of the planar. To 
manage the feeding to the SWA elements, it was 
additionally divided into 8 4 sub arrays, each coupled to a 
multistage divider. 

Our project's main goal is to create a 10 * 10 
pencil-shaped SWA antenna and determine its gain, power 
handling, directivity, and efficiency. Slot displacements 
from the wall centerline are used to determine the 
antenna's side lobe level (SLL) and to examine the antenna 
radiation pattern. To find the coefficency and 
displacement for related ways to compute the frequency 
range, models based on Taylor and Chebyshev 
distributions are utilised. A prototype SWA has been 
simulated and tested, with results that are consistent with 
the design. 
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2.1 RELATED WORK 

Rashad Hassan [1] et.al. This thesis presents the 
design and fabrication of a single waveguide resonator-
based aperture antenna with a 3rd order band pass filter 
to demonstrate the concept. The design concept is further 
improved to merge band pass filters with an aperture 
antenna array based on NN waveguide resonators. This 
serves to both boost the array's gain and provide filtering. 
The antenna array-filter is the integrated component here. 
Tarek Naous [2] et.al The design of filled SWAs was not 
optimal for a specific SLR, according to the few studies 
that looked into it. Based on input specifications of the 
antenna's SLR, reflection coefficient, frequency of 
operation, and relative permittivity of the dielectric 
material, we formulate the design of dielectric-filled SWAs 
as a regression problem for an accelerated design process 
in the case of specified SLRs, where the developed ML 
model predicts the filled SWA's design parameters with 
very low error. Coburn, William [3] et. al. The array is 
modular to make fabrication easier and to improve 
transportability and reparability (with four symmetric 
modules). The use of a rectangular waveguide corporate-
feed network reduces the antenna subsystem volume (i.e., 
depth), allowing the HPM source to be integrated into the 
feed structure. An S-band array and feed structure were 
built and integrated for laboratory testing. The array was 
manufactured with WR-284 copper waveguide and brass 
end caps to a 5-mil tolerance. The array's design, 
fabrication, assembly, and testing are all taken care of. We 
present preliminary test findings for one of the four 
modules in the full array. The array's performance will 
need to be "fine-tuned" after fabrication, as expected. 

M. Al-Husseini [4] et.al. The antenna is optimised 
for 3 GHz operation. The length and width of the slots are 
optimised for this frequency, and their displacements are 
calculated with a 20 dB sidelobe level ratio in mind. The 
azimuth plane beam is then symmetrically focused and 
increased by adding two rectangular metal sheets as 
reflectors. Giovanni Andrea Casula [5] et.al. The T-junction 
feeding the array, the effect of interaction between each 
slot coupler of the feeding network and the radiating slots 
closest to this coupler, and the waveguide bends are all 
under consideration. When compared to the ideal 
scenario, all of these effects can significantly increase the 
initial sidelobes, resulting in a significant decrease in array 
performance. 

3. TECHNICAL SPEICIFCATION 

1. Antenna Configuration 

Because the desired frequency is 3 GHz, the SWA 
is built using a WR-284 waveguide with a = 2.8400 and b 
= 1.3700. One end of the waveguide is shorted, while the 
other is fed. One of its broadsides has ten elliptical 

grooves carved into it. The slots are separated half the 
guide wavelength from centre to centre, with the guide 
wavelength in this case being g = 138.5 mm. The slots are 
arranged so that the centre of the first, Slot1, is g/4 away 
from the waveguide feed and the centre of the last, Slot10, 
is g/4 away from the waveguide's short-circuited side. 
The waveguide's entire length is thus 5g. 

The width of each slot is fixed at 5 mm, which is 2 
times the ellipse's minor radius. This is determined as 
follows: for X-band SWAs, the adopted width of a 
rectangular slot is 0.062500, equivalent to a = 0.9 00 in 
the literature. The width of the elliptical slot for this S-
band SWA is calculated from 2.8400 0.0625/0.9, which is 
0.19700 or 5 mm, using proportionality. The length of the 
slots (twice the major radius) is projected to be greater 
than half the free space wavelength due to their elliptical 
form. 

The proposed method for determining the slot 
displacements from the waveguide axis for a desired SLR 
is described. The dimensions and guide wavelength of the 
waveguide utilised in the radiating SWAs are then used to 
create the feeder SWA. The radiating SWAs are eventually 
placed side by side, and the feeder is connected to them. 

 

Fig: Panel Design Structure 

The three-dimensional SWA arrays in are mirrored in 
their two-dimensional equivalents in the xz-plane, as 
illustrated in Figure, allowing for the creation of the 
proposed antenna while still offering a physical 
understanding of its geometrical structure. As a result, the 
proposed case's evolution is presented. The Type A 
conventional antenna [9] with a wide flare-angle reflector 
in Figure 5 provides an optimal gain of more than 30 dB at 
the cost of a huge antenna size. The most straightforward 
way to shrink the antenna's physical size is to shrink the 
reflector. Unfortunately, using this method reduces 
antenna gain significantly. 

The slots length can be either nonuniform, in which case 
the length of each slot is computed using optimization 
algorithms, or uniform, in which case the length of each 
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slot is considered to be uniform for simplicity. Choosing 
uniform slot lengths can also help you achieve your goals. 

 

The location of the slots along the length of the SWA is 
critical for keeping the slots fed in phase. The electrical 
distance 2d/g2d/g, with gg being the guide wavelength 
defined as the distance travelled by the electromagnetic 
wave down the length of the waveguide to suffer a phase 
shift of 22 radians, determines the phase shift between 
consecutive slots. (2) is used to determine it, with 00 
representing the free-space wavelength and c 
representing the speed of light.. 

 

The waveguide operates as a transmission line by using 
longitudinal slots. The TE10 mode dispersion is 
symmetrical when a transverse electric field is applied to 
each slot. Each slot is depicted as a shunt element using an 
equivalent transmission line. When the width of the slots 
is narrow[12], their offsets are not too great, and the 
height of the waveguide is relatively large, this assumption 
has been proven to be valid using the method of moment. 

 • The antenna converts electrical energy from the 
transmitter into electromagnetic energy, which is 
then radiated into space; on the receiving end, the 
antenna converts electromagnetic energy into 
electrical energy, which is then fed into the 
receiver: The fundamentals of transmit and 
receive antenna operation[12] 

 • Transmission - sends electromagnetic energy 
into space 

 In two-way communication, the same antenna can 
be used for transmission and reception, thanks to 
the high frequency microwave's short 
wavelength, which allows for the use of highly 
directional antenna. The use of a microwave 
antenna for long-distance signal transmission is 
more cost-effective. The use of a waveguide is 
ideal for signal transmission across short 
distances. 

4. Metrical Method  

 Chebyshev Distribution at 20 dB SLR The 
objective in this case is a 20 dB SLR, and the cns are 
chosen using a Chebyshev distribution. Slot displacements 

and coefficients The coefficients cns of a Chebyshev 
distribution are determined using the following formulae. 
A generalized Chebyshev array's array factor is written as: 

 

Where:  

• Tx signifies a Chebyshev polynomial of order x,  

• n = cosh[cosh1(Rn)/(Nn 1)],  

• u = 2(d/)(cos cos 0),  

• Rn denotes the sidelobe level ratio of the nth basis 
Chebyshev array, and Nn denotes the number of elements 
of the nth basis array. The array factor can be stated as: 
with uniform spacing and a symmetrical amplitude about 
the centre 

 

Where m equals 1 for m = 1 and equals 2 for m = 1. Finally, 
the excitation coefficients are found  

 

where:  

 

Table: Slot displacements in radiating and feeder 
SWAs for the 8 × 8 planar SWA example 
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First, the Feeder SWA and the eight radiating SWAs are 
made. The slots were drilled with a 3 mm type carbide on 
a HAAS VF-6 three axis milling machine with an accuracy 
of 0.001 mm. 

Coefficients and Slots Displacements  

The following formulae can be used to calculate 
the cns for a Taylor one-parameter distribution. For a 
continuous line distribution of length l, the excitation 
coefficients, In(z), are equal 
to

 

The current magnitudes of an N-element linear array with 
symmetric excitation are equivalent as in the discrete case 
[12] 

 

A 30 dB Taylor (one-parameter) taper is necessary for a 
20 dB SLL for the SWA. The derived coefficients, as well as 
the slot displacements. 

Table −SWA SLL of 20 dB due to 30 dB Taylor (one-
parameter) coefficients and related slots 

displacements. 

 

A Taylor (one-parameter) distribution is utilised 
in this example to generate a SWA SLR of 30 dB. The taper 
coefficients for a 40 dB Taylor (one-parameter) 
distribution are needed for this, and they're listed in Table 
3 with their corresponding slots displacements. The 
results demonstrate a 3 GHz antenna resonance with a 
15.3 dB peak gain. 

Table 3 lists the binomial coefficients and corresponding 
slots displacements for the case of ten slots. The obtained 
SLR is 33.5 dB, and the max gain is 15 dB for these 
displacement values. The HPBW in the Y Z-plane rises to 
11.1 degrees. 

Table: Coefficients and corresponding slots 
displacements 

 

Measurement 

A prototype SWA array was constructed and 
tested to confirm the procedure presented. The waveguide 
in my hand is 50 cm long. Because this length is 
insufficient to accommodate 10 slots while adhering to the 
various slot distance and length criteria, the design was 
modified to include 7 elliptical slots. The distance between 
each of these two edge slots and the adjoining waveguide 
edge has been raised from g/4 to 3g/4 to avoid the two 
edge slots intersecting the waveguide flanges, resulting in 
a total SWA length of 4.5g. The Python computer software 
that was utilised for this design allowed for this 
modification. The SWA is built for a frequency of 50 kHz to 
maintain the waveguide length of 50 cm. , 4.5g = 50 cm, 
and g = 111.11 mm. The elliptical slot length has been 
tuned to attain to this resonance frequency after the SWA 
was designed with the correct uniform distribution 
displacement. It is discovered to be 48 mm. The SWA was 
later built to radiate with a sidelobe level of less than 20 
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dB using this optimised length and a slot width of 5 mm. In 
this case, the excitation coefficients were calculated using 
a Chebyshev distribution of 35 dB. lists these coefficients 
as well as the related slot displacements. 

The antenna design and a shot of the prototype 
may be found here. The reflection coefficient plot provides 
a comparison of two measured data and simulated results 
computed using both CST and HFSS software. The antenna 
had some protrusions on the corners of the elliptical slots 
during Measurement 1, which were filed for Measurement 
2, giving the slot a perfect elliptical form. In comparison to 
the measured data, the gain patterns estimated in both 
HFSS and CST are. Despite the tiny variation, which is 
attributable to other fabrication flaws, a credible parallel 
has been shown by inspecting the S11 and pattern figures. 

5. EXPERIMENTAL RESULTS 

The patch antenna is made up of three bricks: one for 
the radiating plate, one for the microstrip line, and one for 
the substrate, which uses CST and HFSS. A completely 
electrically conducting boundary condition defines the 
ground plane. Assigning coordinates is done as follows. 
The ground plane and substrate begin at this point (0,0,0). 
The substrate's length, L, and breadth, W, are chosen to be 
28.1 mm and 32 mm, respectively. The patch's length is 
0/2 12.45 mm, and its breadth is half that of the ground, 
with a substrate of 16 mm. The patches, on the other hand, 
begin at (28.1/4, 32/4, 0).The patch's beginning point is 
14 percent of the ground plane's overall width, and it 
stretches 12.45 mm in the positive x-direction. Similarly, 
the patch is 14 of the total length of the ground plane in 
the x-y plane (z=0) in the y-direction. Furthermore, the 
feed line should be situated between the patch's starting 
point and finishing point values. 

 

Fig: SWA Design Calculation 

Select File > Save As from the File menu in the Ansoft 
HFSS window. Type the desired file name in the Save As 
window. Select the Save button. This is how your final 
model should look: 

 

Fig: SWA Antenna 

A slot antenna is made up of a metal surface having a 
hole or slot carved out of it, commonly a flat plate. When a 
driving frequency is used to drive the plate as an antenna, 
the slot radiates electromagnetic waves in the same way 
that a dipole antenna does. The radiation distribution 
pattern is determined by the form and size of the slot, as 
well as the driving frequency. The slots on the waveguide 
will be assumed to have a narrow width. Increased width 
increases bandwidth (remember that a fatter antenna 
frequently has more bandwidth); nevertheless, a wider 
width comes at the cost of increased cross-polarization. 
Fractional Bandwidth (FBW) for thin slots can be as low as 
3-5 percent, whereas FBW for large slots can be as high as 
75 percent. Figure shows an example of a slotted 
waveguide array (dimensions supplied by length a and 
width b) slot waveguide with dimensions given by length a 
and width b. 

Table: Microstrip Line 

 

it would now be simple to draw the model. You only 
need to enter in the coordinates. Let's begin by sketching 
the ground plane. Please refer to Table 3 for Ground Plane 
coordinates. Choose Draw> Box from the menu. Enter the 
box position (x, y, z) in the coordinate entry fields in Table 
3, then the opposite corner of the base rectangle (dx, dy, 
dz), where dx, dy, and dz stand for full length, full width, 
and full height, respectively. The ground plane's 
dimensions are given. When the properties dialogue box 
displays, double-check that the Position, Xsize, Ysize, and 
Zsize values are correct. 
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Select the Attribute tab and type gnd as the name's 
value. Assign PEC (Perfect Electric Conductor) material to 
the object by clicking on it. Then select your preferred 
colour and transparency value. Select the OK option. 

Let's draw the substrate next. The substrate and the 
ground plane have the same dimensions. Because the 
ground plane is at z = -0.794 and has no thickness (dz=0), 
the substrate must be 0.794 mm thick, and since the 
beginning point was zero, the complete height must be in 
the -z direction. Draw > Box with the coordinates from 
Table 4, set the box's location (x, y, z), and enter the box's 
opposite corner (dx, dy, dz). 

Coordinates are correct. Enter Substrate in the name 
value box on the Attribute tab. Assign Rogers RT/Duroid 
5880(tm) with a relative permittivity of 2.2 to the 
material. Click OK. Select your preferred colour and 
transparency value once again. Select the OK option. 

Finally, make the patch. Knowing that the patch 
should be in the middle, calculating the coordinates from 
the ground and substrate dimensions is simple. The 
patch's centre, ground plane, and substrate are all the 
same size and are located at (28.1/2, 32/2, 0). To calculate 
the starting point, subtract the centre point coordinates 
from the substrate coordinates, and the patch's complete 
length, width, and height are given. Draw > Box, your 
coordinates are correct. Under the name value box, type 
Patch in the Attribute tab. Assign PEC to the stuff now. 
Click OK. Select your preferred colour and transparency 
value once again.. 

RESULT AND DISCUSSION  

Performance Analysis 

A few characteristics, including as return loss, 
bandwidth, radiation pattern, directivity, and antenna 
gain, determine the performance of a designed antenna. 

 

Fig: 2.4 GHz frequency radiation pattern. 

It shows the antenna gain when phi is 90 degrees. An 
antenna's gain is defined as the ratio of intensity in one 
direction to the radiation intensity that would be obtained 
if the antenna's power was emitted in an isotropic way. 
The antenna's gain is proportional to its directivity. An 
antenna's gain refers to its efficiency as well as its 
directional capabilities. Gives the relationship between an 
antenna's gain and directivity. 

 

Fig: Radiation pattern in three dimensions at 2.4 GHz 

In terms of SS11, far-fields E-plane and H-plane, and gain, 
modelling results for the proposed array antenna 10 *10 
are displayed. The array antenna's simulated resonance 
frequency is 2.4 GGGGGG, with a reflection coefficient of 
around 34.36 dddd. This array antenna's simulated 
impedance bandwidth is around 30 MHz (2.38-2.41 GHz). 
The array antenna 10 *10's simulated two-dimensional 
far-fields E-plane and H-plane at 2.4 GHz. It's worth noting 
that the proposed array antenna 10*10 has a very directed 
emission pattern in both planes E and H. The array 
antenna has also been shown to have a very high gain of 
roughly 10.22 dB. Table 3 compares the performance of 
the proposed array antenna with that of other array 
antennas for RFID systems. The proposed array antenna 
has a modest and acceptable size and a substantially 
higher gain than existing reference works, as shown in the 
Table. 

 

Fig: Return loss versus. frequency for a patch antenna 
operating at 2.4 GHz 
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Because of mismatches between the transmission 
line and the feeding points, the return loss shows how 
much feeding power was reflected back at the patch 
antenna's port. Reflections at the antenna port move back 
towards the source when the antenna and transmission 
line are not exactly matched, forming a standing wave. 
High return loss is required for a good antenna. The 
antenna radiates best at the chosen resonance frequency, 
2.4 GHz, with a return loss of 20 dB, according to from. 

Bandwidth  

The bandwidth of an antenna refers to the 
frequency range over which it can function properly. The 
antenna's bandwidth is defined as the number of Hz for 
which the SLR is less than 2. The graph return loss against 
frequency at point 10 dB[11] can be used to determine the 
bandwidth value. The value of bandwidth is 0.28 dB, as 
demonstrated in the graph of return loss against 
frequency. The bandwidth restriction of various antenna 
types varies. 

It indicates how much power is reflected back to 
the source from the antenna. The acceptable value for an 
antenna is 1 VSWR 2. If the VSWR value is 1, the antenna 
receives all of the power it is provided. Figure 6 shows 
theFrom figure 6, the value for designed antenna is 1. 

 

Fig: frequency plot of the patch antenna. 

 

Fig: Simulated E and H planes at 2.40 GHz 

The prototype antennas' design and a shot of the 
prototype. The reflection coefficient plot compares two 
measured results with simulated results computed using 
both CST and HFSS software. 

CST was used to replicate the planned planar SWA. Table 2 
lists the computed SLR, HPBW, and gain in the E- and H-
planes, with a 3D gain pattern plot in Figure 5. As can be 
seen, a pencil form pattern was achieved with an SLR of 
not less than 20 dB in both planes, narrow HPBW, and is 
suited for HPM applications. If the required SLR utilised to 
detect the slots displacements is made larger than 20 dB, 
lower sidelobe levels are easily obtained. 

Table: 10*10 SWA Antenna Simulation Results 

 

 

Fig: A) E-plane radiation pattern simulation (B) 
element patch antenna at 2.4 GHz 

 

Fig: For the scenario of non-uniform slots 
displacements with Chebychev distribution, the 

antenna's Y Z-plane pattern for 20dB 



          International Research Journal of Engineering and Technology (IRJET)       e-ISSN: 2395-0056 

                Volume: 09 Issue: 05 | May 2022              www.irjet.net                                                                        p-ISSN: 2395-0072 

  

© 2022, IRJET       |       Impact Factor value: 7.529       |       ISO 9001:2008 Certified Journal       |     Page 1469 
 
 

 

Fig: The findings of the measured and simulated 
reflection coefficients were compared. 

The feeder SWA is then welded to the radiating 
SWAs utilising the back of the radiating SWAs' L-shaped 
copper corners. Figure 6 depicts the manufactured planar 
SWA. In Figure 7, the simulated gain pattern results are 
compared to the measured ones. The findings of the 
measured reflection coefficient are also shown.  

Figure 8 shows the results of simulations using CST. As can 
be observed, the measured results are extremely similar to 
the simulated ones, and they are also consistent with the 
design goals. This antenna array's capacity to break down 
has also been investigated. On the slot responsible for the 
most radiation, the maximum voltage value has been 
computed. The slots in the centre of the array system give 
the most radiation because they have the highest fed 
power intake from the SWA feeder and the greatest 
displacements from the SWA branch line centerline where 
the slots are located.. The maximum voltage on these slots 
is found to be 5.55 105 V/m when the system is simulated 
with a high input power to the feeder SWA of 6.25 MW. 
This maximum voltage is still lower than the 
commencement of air breakdown, which can cause the air 
to begin to break down at 3 106 V/m. If desired, a bigger 
slot width value can be used to provide a lower maximum 
voltage and hence a higher value of power radiated. 

6. CONCLUSION 

The performance parameters of the developed 
SWA in this research work are shown utilizing the basic 
antenna parameter characteristics of resonant frequency, 
return loss (S11), VSWR, Bandwidth, Gain, Directivity, Half 
Power Beam width (HPBW), and Efficiency.. 
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